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Location of Media 
 
All of the media for WebBlender, including clip art, photographs, backgrounds, 
music, and themes, is stored outside of the WebBlender folder on the computer. 
All users on the computer must have read access to these files to be able to use 
them in WebBlender. 
 
On Macintosh OS X, the files are located at: 
 
/Library/Application Support/Tech4Learning/Shared 
 
On Windows XP and Vista, the files are located at: 
 
C:\Program Files\Tech4Learning\Shared 
 

Changing the Location of the Shared Media 
 
On Macintosh OS X, it is not possible to change the location of the Shared media 
folder. 
 
On Windows, it is possible to place the Shared media folder on a network drive in 
order to save space on local computers and simplify making universal changes to 
the media.  
 
You will need to edit the Registry on the local computer to make this change. 
 
To edit the Registry, open the Microsoft Registry Editor. 
 
Navigate to the following key: 
 
My Computer\HKEY_LOCAL_MACHINE\SOFTWARE\TECH4LEARNING 
 

 
 
Double-click the SHARED registry value. 
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You will see the Edit String dialog. 
 

 
 
Change the Value data to the network location of the Shared folder. 
 

 
 
Click the OK button. 
 
Close Registry Editor. 
 
The next time WebBlender is launched on this computer, it will look for the media 
resources on the network drive you specified. 
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Adding Folders to the Library 
 
There are two ways to add media to the Library. You can copy files and folders 
into the Clip Art, Buttons, and Sounds folders in the Tech4Learning shared 
library, or you can tell WebBlender to look for folders stored elsewhere on your 
computer. 

Add Media to Categories in the Library 
 
You can specific media elements, or additional folders of media into their 
corresponding folder in the Library.  
 
On Macintosh OS X, the library folders, including clip art, buttons, and sounds, 
are located at: 
 
/Library/Application Support/Tech4Learning/Shared/ 
 
On Windows 2000 and XP, the library folders are located at: 
 
C:\Program Files\Tech4Learning\Shared\ 
 
Any folders placed in these folders will appear in these categories in the Library 
in WebBlender. 

Supported Clip Art Formats 
 
The following image file formats are supported: 
 

BMP   JPG   GIF 
PNG  TWI   PXI 
PXT  IBF  IBT  

Supported Sound Formats 
 
The following sound file formats are supported:  
 

WAV   MP3  MIDI 
 



Administrator’s Guide to WebBlender  Version 1 

 
© 2007 Tech4Learning, Inc.  Page 7 of 36 

Pointing to Additional Folders to Display in the Li brary 
 
You can add folders on your computer or network to the Library. This allows you 
to add additional art to WebBlender without moving/copying it into the Shared 
media folders. 
 
On Windows, go the Edit menu and choose Preferences. 
 
On Macintosh, go to the WebBlender menu and choose Preferences. 
 
You will see the Preferences dialog. 
 
Click the Library category. 
 

 
 

Add User Documents and Pictures 
 
To add your My Documents and My Pictures (Windows XP) or Documents and 
Pictures (Mac and Windows Vista) folders, click the check boxes. 
 

 
 
These folders will appear in the Library pane.  
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Add Additional Folders 
 
You can add other folders from your computer or network to the Library.  
 
To add another folder, click the Add button. 
 
On Windows 
 
You will see the Choose Folder dialog. 
 

 
 
Locate the folder you want to add to the Library.  
 
Click the folder to select it. 
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Click the Open button. 
 
On Macintosh 
 
You will see the Choose Folder dialog. 
 

 
 
Locate the folder you want to add to the Library.  
 
Click the folder to select it. 
 

 
 
Click the Choose button. 
 
You will see the folder name in the Added Libraries list. 
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Add all the folders you want to use.  
 
When you are finished, click the OK button. 
 
Click the Library tab above the editing panel. 
 
You will see the folders in the Library. The folder you added will be in the list. 
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Using Twist to Create New Shapes 
 
You can use TwistTM to create new shapes you can use in WebBlender. A shape 
you can draw in WebBlender is simply a shape created in Twist and exported 
using the Cool Shape option. When placed in the Cool Shapes folder, it will 
appear as an option in the Shape tool in WebBlender. 

Creating a Shape 
 
Open Twist. 
 
Use one of the tools on the tool palette to draw a filled shape.  
 
Use the First Color box in the Fill area of the editing panel to change the fill color 
for the shape to white. 
 

 
 

Exporting your Shape on Windows 
 
Note: You must be logged in as an administrator on your computer to save 
directly into the Cool Shapes folder. If you are not an administrator, export the 
Shape to your Desktop or My Documents and move the file into the Cool Shapes 
folder when you are logged in as an administrator. 
 
Select the shape. 
 
Go to the Object menu and choose Export to Cool Shapes. 
 
You will see the Export As dialog. 
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Type a name for the shape in the File name field. 
 
Click the Save button. 
 
This shape will be available from the Shape button on the tool palette the next 
time that you open WebBlender. 

Exporting your Shape on Macintosh 
 
Note: You must be logged in as an administrator on your computer to save 
directly into the Cool Shapes folder. If you are not an administrator, export the 
shape to your Desktop or Documents and move the file into the Cool Shapes 
folder when you are logged in as an administrator. 
 
Select the shape. 
 
Go to the Object menu and choose Export to Cool Shapes. 
 
You will see the Save dialog. 
 

 
 
Type a name for the shape in the Save As field. 
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Click the Save button. 
 
This shape will be available from the Shape button on the tool palette the next 
time that you open WebBlender. 
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Creating New Buttons 
 
You can use TwistTM to create new buttons you can add to the WebBlender 
library and edit in WebBlender. A button is set of shapes created and exported 
from Twist.  Once you create the button in Twist, you add it to WebBlender, add 
and format text, and export as a button. 

Drawing the Button Art in Twist 
 
Open Twist. 
 
Use the drawing tools, fills, and opacity to create a button. 
 
If you would like to be able to change the color of the button in WebBlender, 
make sure that the very back layer is large and a solid color. 
 

 
 
In this example, the button will look like a 3-dimensional dot. The large 
background layer is a solid color so it can be changed in WebBlender. The layer 
on top is radial gradient of several whites and blacks of varying opacities. 
 
When you have created your shapes, go to the Edit menu and choose Select All. 
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Exporting your Shape on Windows 
 
Go to the Object menu and choose Export to Cool Shapes. 
 
You will see the Export As dialog. 
 

 
 
 
Navigate to the Desktop. 
 
Type a name for the shape in the File name field. 
 
Click the Save button. 

Exporting your Shape on Macintosh 
 
Go to the Object menu and choose Export to Cool Shapes. 
 
You will see the Save dialog. 
 

 
 
Use the Where pull-down menu to choose Desktop. 
 
Type a name for the theme in the Save As field. 
 
Click the Save button.
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Finishing the Button in WebBlender  
 
Open WebBlender. 
 
Click the Add image button on the tool palette. 
 

 
 
Navigate to the button image you just exported from Twist. If your computer is set 
to show file extensions, it will have a .snippet at the end of the file name. 
 

 
 
Click the Add a Text Object button on the tool palette. 
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You will see a text object on the page. 
 
Resize the text box and use the options on the Options panel to choose a font, 
size, alignment, and color for the text.  
 
Type the text you want to show in the button. Remember, the end user will be 
able to change it if they need something different. 
 

 
 
Go to the Edit menu and choose Select All to select both the text box and the 
button. 
 
Go to the Options menu and choose Create Button. 
 
The appearance of the button won’t change, but now the editing panel will 
change to show the button options. 
 
You can already see that you can change the background color in the Fill area. 
 

 
 
Click the Font Edit button. 
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Choose the Center placement option. 
 

 
 
 
Click the Go Back button. 
 

 
 
The button is now ready to be exported. 

Exporting your Button on Windows 
 
Note: You must be logged in as an administrator on your computer to save 
directly into the Buttons folder. If you are not an administrator, export the button 
to your Desktop or Documents and move the file into the Buttons folder when you 
are logged in as an administrator. 
 
Go to the Options menu and choose Export Button. 
 
You will see the Export As dialog. 
 
If you would like the button to appear in the WebBlender Buttons library, navigate 
to:  
 
C:\Program Files\Tech4Learning\Shared\Clip Art\Buttons 
 
Choose the folder that most fits your type of button and open it. 
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Give the button a name. 
 
Click the Save button. 
 
The next time you navigate to this Buttons folder in WebBlender, you will see your 
button. 

Exporting your Button on Macintosh 
 
Note: You must be logged in as an administrator on your computer to save 
directly into the Buttons folder. If you are not an administrator, export the button 
to your Desktop or Documents and move the file into the Buttons folder when you 
are logged in as an administrator. 
Go to the Options menu and choose Export Button. 
 
You will see the Export As dialog. 
 
If you would like the button to appear in the WebBlender Buttons library, navigate 
to:  
 
Macintosh HD/Library/Application Support/Tech4Learning/Shared/Clip Art/Buttons 
 
Choose the folder that most fits your type of button and open it. 
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Give the button a name. 
 
Click the Save button. 
 
The next time you navigate to this Buttons folder in the WebBlender Library, you 
will see your button. 
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Using WebBlender to Make Web Site Themes 
 
You can create your own themes to use with WebBlender and Share. 
WebBlender and Share display themes from a specific folder in the Theme 
Chooser dialog. You can save themes in this folder to use with WebBlender and 
Share. 
 
Themes are WebBlender sites that contain page templates for the title page, an 
text page, a landscape image page, and a portrait image page. 
 
Open WebBlender and make a new WebBlender site. 
 

 
 
Click the Add Page button and choose New Blank Page. 
 
Add pages until you have four pages in the site. 
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Naming the Pages 
 
Edit the title of each page. The page title is used by the Theme Wizard to decide 
which page to use when building the site. 
 
Click a page, go to the Options menu, and choose Edit Page Title.  
 
Name the first page: title 
 
Name the second page: text 
 
Name the third page: landscape 
 
Name the fourth page: portrait 
 

 

Decorating the Theme 
 
Add a background to any page. 
 
Use the Apply to All Pages button to apply the background to every page. 
 

 
 
Add any graphic elements, pictures, and rectangles you want to have on every 
page. 
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Lock all of these elements so people who use your theme cannot edit them. 
 
To lock an object, select the object and then go to the Objects menu and choose 
Lock. 
 
Select the title page. 
 
Add and format text objects for the title page. Do not enter text in the text objects. 
 

 
 
Select the text page. 
 
The text page is used to add blank pages to a site. Add and format any text 
objects for this page. Do not enter text in the text objects. 
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Select the landscape page. This is the page that will be used for images that are 
landscape format (wider than they are tall). 
 
Add any graphic elements, such as image borders, that you want on this page. 
 
Add and format any text objects you want to have on the landscape page. Do not 
enter text in the text objects. 
 

 
 
Select the portrait page. Add any graphic elements, such as image borders, that 
you want on this page. Add and format any text objects you want to have on the 
landscape page. Do not enter text in the text objects. 
 
Add an Image Place Holder 
 
The portrait and landscape pages need a rectangular place holder for the images 
that will be added to them.  
 
Click the Shape tool on the tool palette and choose the Rectangle shape. 
 

 
 
Click and drag a rectangle in the place where you want images to be added to 
the theme pages. 
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While the rectangle is selected, right-click the rectangle and choose Edit Alt Tag. 
 
You will see the Edit Alt Tag dialog. 
 
Type: image 
 

 
 
Click the OK button. 
 
Select the portrait page.  
 
Add a rectangle for the location of the image.  
 
Right-click to edit the Alt Tag and change the name of this rectangle to image as 
well. 
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Adding Navigation 
 
Before you can save the theme, you need to add navigation to every page. 
 
Add navigation buttons, such as next page, previous page, and home page, to 
each page in the theme. 
 

 
 
The theme is now finished. You can save the theme into the themes folder so 
that it is available when you create a new theme site. 
 
Go to the File menu and choose Save as Template. 
 
You will see the Theme Checker dialog. 
 

 
 
Click the Check button. 
 
You will a dialog showing whether or not your theme includes all of the necessary 
components. 
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Click the Continue button. 

Saving the Theme on Windows 
 
Note: You must be logged into your computer as an administrator to save directly 
into the Themes folder. If you are not an administrator on your computer, save 
the theme to a common location and have a computer administrator move the file 
for you. 
 
You will see the Save Site As dialog. 
 
If you would like the button to appear in the WebBlender Themes, navigate to:  
 
C:\Program Files\Tech4Learning\Shared\Themes 

 

 
 
Choose a folder of themes. 
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Type a name for the theme in the File name field. 
 
Click the Save button. 
 
This theme will be available the next time you use the Theme Chooser. 

Saving the Theme on Macintosh 
 
Note: You must be logged into your computer as an administrator to save directly 
into the Themes folder. If you are not an administrator on your computer, save 
the theme to a common location and have a computer administrator move the file 
for you. 
 
Go to the File menu and choose Save as Template. 
 
You will see the Save Site As dialog. 
 
Click the down arrow next to the Save As field. 
 

 
 
You will see the more options. 
 
If you would like the button to appear in the WebBlender Themes, navigate to:  
 
Macintosh HD/Library/Application Support/Tech4Learning/Shared/Themes 
 
Type a name for the theme in the Save As field. 
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Click the Save button. 
 
This theme will be available the next time you use the Theme Chooser.  
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Program Defaults 
 
You can change certain program defaults in order to better address the needs of 
your students. 
 
These preferences include: 

·  Changing the default font 
·  Changing the size of scaling handles 

Changing the Default Font 
 
You can change the default font for new text objects. 
 
On Windows, go to the Edit menu and choose Preferences. 
 
On Macintosh, go to the WebBlender menu and choose Preferences. 
 
You will see the Preferences dialog. 
 
Click the Text Options item in the list. 
 

 
 
Use the Font pull-down menu to select a new default font. 
 
Use the Size slider to select a new default size. 
 
Choose the default alignment you want to use. 
 

 
 
Click the OK button. 
 
New text objects will use these settings.
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Changing the Size of Scaling Handles  
 
You can change the size of the handles around images, buttons, and text objects 
to make them easier to use. 
 

 
 
On Windows, go to the Edit menu and choose Preferences. 
 
On Macintosh, go to the WebBlender menu and choose Preferences. 
 
You will see the Preferences dialog. Click the Accessibility tab. 
 

 
 
Click and drag the Handle Size slider to the right. 
 

 
 
Click the OK button. 
 
You will now see larger handles around objects. 
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Troubleshooting 
This next section provides troubleshooting tips for WebBlender. 
 
Topics include: 

·  Windows XP SP2 Security Settings 
·  Installation Problems 
·  Proxy Settings 
·  Session Logs 
·  Error Reporting 

 

Windows XP SP2 Security Settings 
 
Windows XP Service Pack 2 introduced new security features that may block 
some WebBlender and Share pages or features, such as sounds and scaling, 
when you are looking at sites you have published locally. These security settings 
will also prevent the WebBlender and Share help system from functioning 
properly.  
 
You can change the settings in Internet Explorer so the content is not blocked. 
 
If content on a page is blocked, you will see the Information Bar dialog with a 
message. 
 

 
 
Click the OK button. 
 
There will be an Information Bar at the top of the browser window. 
 

 
 
Click the right side of the Information Bar. You will see a menu of options. 
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Click Allow Blocked Content . 
 
You will see a Security Warning dialog. 
 

 
 
Click the Yes button. 
 
You will be able to view the content. 
 
Installation Problems  
 
Some anti-virus programs interfere with the installation of the Java components 
that are installed by WebBlender. If this occurs during installation, WebBlender 
will not launch. 
 
You can resolve this issue by following these steps: 
 

1. Log into the computer as an Administrator. 
2. Disable any anti-virus software. If you are using Norton AntiVirus, right-

click the icon in the System Tray and choose "Disable Auto-Protect". For 
other antivirus software, consult the application's documentation. 

3. Uninstall any existing versions of Java using the Add or Remove 
Programs control panel. 

4. Run the WebBlender installer again. 
5. Enable your anti-virus software. 
6. Restart the computer and then launch WebBlender. 
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Proxy Server Settings 
 
You can add your school’s proxy server settings to WebBlender. This will help 
WebBlender communicate with the Pics4Learning Web site. 
 
On Windows, go to the Edit menu and choose Preferences. 
 
On Macintosh, go to the WebBlender menu and choose Preferences. 
 
You will see the Preferences dialog. 
 
Click the Proxy item in the list. 
 

 
 
Click the Use Proxy Server check box. 
 
Enter the address and port number for the proxy server in the Proxy Server and 
Port Number fields. 
 

 
 
If you have a user ID and password to access the proxy server, click the Use 
User Settings check box. 
 
Enter your user identification in the User ID field. 
 
Enter your password in the Password field. 
 

 
 
Click the OK button. 
 
Your proxy settings will be saved. 
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Session Logs 
 
WebBlender stores a log for each user session. In case there is a program error 
during the session, these logs help Tech4Learning identify and fix errors in the 
program. 
 
Users can also view and save the log file from within WebBlender.  
 
After an error occurs, users should save the log file and email it with a description 
of the error to Tech4Learning technical support at support@tech4learning.com. 
 
On Macintosh, go to the WebBlender menu and choose About WebBlender. 
 
On Windows, go to the Help menu and choose About WebBlender. 
 
You will see the About dialog. 
 

 
 
Click the Open Session Log link. 
 
The session log will open in a text editor, usually Text Edit (Macintosh) or 
Notepad (Windows). 
 
Save the file to a common location so that it may be attached to an email. 
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Error Reporting 
 
If WebBlender encounters an error, you can report it to Tech4Learning with the 
click of a button. 
 
If you see an Error dialog, click the Report button. 
 

 
 
A report will be sent to Tech4Learning’s development team, enabling them to fix 
the problem. 


